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No final desta aula,
@s alun@s deverao:

« Compreender nocoes basicas dos modelos de equag¢oes estruturais
 Compreender a diferencga entre variaveis latentes e manifestas
 Compreender o processo de definicao e analise de MEQ

* Gerar modelos de equag¢oes estruturais com recurso do programa AMOS

* Interpretar resultados dos modelos de equacoes estruturais com recurso do
programa AMOS
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MODELOS DE EQUAC&ES ESTRUTURAIS (Structural Equation Modelling):

extensao dos modelos GLM; técnica de modela¢ao generalizada,
para testar a validade de modelos tedricos.

Segue uma abordagem diferente:

Estatistica Classica: AMEE:
Teoria

Teoria) JOELE -

1. Podera este modelo explicar/gerar os dados

1. Qual 0 modelo que descreve os dados observados? Método Confirmatério
observados? Método Exploratério 2. A teoria é o “motor” do processo
g' zados fvjm a dedug;éo Qe Teorias 3. Teorias diferentes podem ser testadas por
- VOVOS dados, novas teorias formalizag&o e avaliagdo de modelos

distintos
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MODELOS DE EQUAGCOES ESTRUTURAIS

Vantagens face as abordagens classicas
1. Inclui no modelo variaveis latentes e manifestas (e o erro previsto)

2. Permite testar modelos complexos com varios tipo de variavel e de relacoes (Permite
testar ajustamento global de modelos e significancia individual de pardmetros num
enquadramento tedrico que engloba varine tinne de mandelnc linearac)

3. Softwares intuitivos AMOS e SMART PLI &)

133095
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AS VARIAVEIS

 Variaveis manifestas ou variaveis observadas: S3o0 variaveis medidas, manipuladas ou
observadas diretamente.
« Variaveis latentes, fatores ou constructos: S0 variaveis nao diretamente observaveis ou

mensuraveis, sendo a sua existéncia indicada pela sua manifestacao em variaveis indicadoras
ou manifestas.

« Variaveis independentes ou exdgenas: as causas destas variaveis residem fora do modelo,
i.e. ndo sao influenciadas por nenhuma outra variavel no modelo.

« Variaveis dependentes ou endégenas: as causas da variacao destas variaveis residem no
modelo, i.e. a variacao destas variaveis é explicada por variaveis presentes no modelo



Wl ANALISE DE DADOS EM GRH

& Management
Universidade de Lisboa

AS COMPONENTES

e Modelo de Medida : define a forma como os constructos hipotéticos ou variaveis latentes sao
operacionalizados pelas variaveis observadas ou manifestas

* Modelo Estrutural : define as relacdes causais ou de associacao entre as variaveis latentes

Modelo de Medida: Modelo Estrutural:
vd.: y=An+e
V.i.: x=A&+0

. Formalmente:
n=Bn+T{+¢

assumindo que (pressupostos):
a. € e m) sdo independentes
b. d e ¢ sdo independentes
c. ¢ e £ sdo independentes
d. ¢, € e d sdo mutuamente independentes

e. Os valores esperados dos erros € 0.
f. B,=0 (uma v.d. ndo é causa e efeito dela mesmo) e (I-B) € nado singular (i.e. tem inversa)
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AS COMPONENTES

* Modelo de Medida: define a forma como os constructos hipotéticos ou variaveis latentes sado
operacionalizados pelas variaveis observadas ou manifestas - . -

* Modelo Estrutural: define as relacdes causais ou de associacao entre as variaveis latentes

. Graficamente:
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A ESTRATEGIA

Validagéo do
modelg Aceitagao ou
Rejeicao do
modelo
Estimacao do
Modelo
) Avaliagdo da
qualidade do
Recolha de Q i Ajustamento
Dados Especificagao e
identificagcdo do
O modelo

() Elaboragédo do B

modelo Tedrico

TEORIA
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1. DEFINIR O MODELO
TEORICO

e “Desenho” formal do modelo, que ilustra
as hipoteses sobre o modelo de medida e
sobre o modelo estrutural:

e Decidir:
1. Que variaveis manifestas operacionalizam
que variaveis latentes; erros
correlacionados?
2. Que relacoes causais entre v. latentes
e/ou v. manifestas devem ser incluidas /
excluidas?
3. Que associacoes (nhao-causais) devem ser
incluidas/omitidas do modelo?

Conhecimento
Satisfacao
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2. ESPECIFICACAO

* Umadas etapas mais complexas...
* Implicatomar decisoes e assumir
alguns pressupostos

Modelos reflectivos: Modelos formativos:
As v. latentes ‘reflectem-se’ nos itens; As ‘v. latentes’ sdo ‘formadas’ pelas manifestas;
. . . _+ Asv latentes manifestam-se através das v. Os itens podem estar ou nao correlacionados,
* Em prlmelro lugar temos de deflnl manifestas positivamente ou negativamente
que ti po de modelo de medida: Os itens devem estar correlacionados positivamente
° . = ~
Modelo reflectivo ou formativo? * Portuguss
Febre 4—@
: Matematica
Aptidao
Dores Musculares @ Acesso
Universidade Biologia
Dores Garganta e g
Psicologi
Nariz congestionado sicebgia
Cansaco ‘—@ (Esta Aptidao de Acesso Univ. ndo €

verdadeiramente latente, ja que € uma combinagéo

(estimaveis pelos modelos de Eq. Estruturais) de v. manifestas (média ponderada). Nao é
estimavel com AEE, mas sim com PLS)
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2. ESPECIFICACAO

* Umadas etapas mais complexas...
* Implicatomar decisoes e assumir
alguns pressupostos

« Depoisidentificar as ligacoes,
erros e possiveis associagcoes com
base nas decisoes (os softwares
ajudam nesta definicdo de
pardmetros)

Algumas ‘regras’ de especificagao:

ANALISE DE DADOS EM GRH

Modelo de Medida (AFC)

manifestas (z,.....z,). O comportamento
das v. manifestas resulta da manifestagao
dos factores latentes;

2. A variancia das v. manifestas (e.g. erros
de medida) que nao é explicada pelos
factores comuns latentes € explicado por
factores especificos latentes (g,,...¢,);

3. Os erros de medida s&o geralmente
independentes (mas podem estar
correlacionados indicando uma fonte de
variagao comum dos itens n&o explicada
pelos factores comuns presentes no
modelo).

1. Factores comuns latentes (£) causam as v.

Modelo Estrutural (RL)

1. Asrelagdes sdo ‘desenhadas’ de causa-
para-efeito

2. Avariancia da v. exdgenasnao explicada
pela combinagéo das v. endégenas ¢
explicada por ‘erros’ (Disturbances ou
Perturbagdes)

Conhecimento
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ESTIMACAO

Contrariamente ao paradigma
classico, nesta abordagem
modelamos as matrizes de
variancias-covariancias (ou de
correlacoes) das variaveis
manifestas (nao os dados
individuais!)

O objectivo da AEE é entao
encontrar um vector de estimativas
dos parametros do modelo (q) que
reproduza o melhor possivel a matriz
S das v. manifestas na populacao
Os softwares de AEE utilizam um

algoritmo iterativo que minimiza uma
funcao da diferenca

Métodos de ajustamento mais usados:

* Maxima verosimilhanga (ML)

* Minimos quadrados ndo-ponderados (ULS)

* Minimos quadrados generalizados (GLS)

* Minimos quadrados ponderados generalizados (WLS)
* Minimos Quadrados Parciais (PLS)

}

Smart-r®

4'll

:
6
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3. ESTIMACAO

AMOS vs PLS (by
ChatGTPT)

Argumentos explicados em:

Dash, G., & Paul, J. (2021). CB-SEM
vs PLS-SEM methods for research in
social sciences and technology
forecasting. Technological
Forecasting and Social Change, 173,
121092.
https://doi.org/10.1016/].techfore.
2021.121092

Criterio

Objetivo

Base

Tamanheo da amostra

Normalidade dos
dados

Foco analitico

Teoria

Complexidade do

modelo

Exemplo de aplicagio

AMOS (CB-S5EM)

Testar e confirmar teorias
Covaridncia

Grande {rn = 2000

Requer normalidade

multivariada
Ajustamento global (fit global)

Base =dlida e prévia

Adequado para modelos

complexos

Validacdo de teorias

psicolagicas

ANALISE DE DADOS EM GRH

PLS (PLS-SEM)

Explorar relagdes e prever variaveis
Varidncia

Pequena a moderada (n < 200)

M&o requer normalidade

Poder explicativo e preditivo (RZ, Q%)

Areas com teorias emergentes ou em

desenvolvimento

Adeguado, mas limitado a modelos

exploratorios

Modelos de satisfagio do cliente

13


https://doi.org/10.1016/j.techfore.2021.121092
https://doi.org/10.1016/j.techfore.2021.121092

v

Wl ANALISE DE DADOS EM GRH

& Management

Universidade de Lisboa

3. AVALIACAO DA
QUALIDADE

(1) Teste do Qui-quadrado

(2) indices de qualidade de
ajustamento

(3) Analise de residuos, estimativa de Estatistica Cléssica- AVEE- .
parametros e fiabilidade individual de Teoria

indicadores [P Dados -

9'®

1. Podera este modelo explicar/gerar os dados
observados? Método Confirmatério

2. A teoria é o “motor” do processo

3. Teorias diferentes podem ser testadas por
formalizacdo e avaliagdo de modelos
distintos

1. Qual o modelo que descreve os dados
observados? Método Exploratério

2. Dados levam a deducéo de Teorias

3. Novos dados, novas teorias
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3. AVALIACAO DA
QUALIDADE

(1) Teste do Qui-quadrado

Hipotese nula: a matriz de covariancia
populacional é igual a matriz de
covariancia estimada pelo modelo

Queremos aceitar a hipotese nula, neste
caso

Wl ANALISE DE DADOS EM GRH

Devemos reportar mas nao é bom indicador :

Muito sensivel a dimensao da amostra
(amostras pequenas: raramente rejeita HO,
Amostras grandes: Rejeita quase sempre HO )
Muito sensivel a violacao da normalidade
multivariada (com risco de rejeicdao de bons
modelos e aceitacdo de modelos maus!)

15
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3. AVALIACAO DA
QUALIDADE

(2) indices de qualidade de ajustamento

Avaliam a distancia relativa entre a matriz
dos dados e a matriz da populacao.

v

Existem centenas!
Tipos de indicadores

Wl ANALISE DE DADOS EM GRH

Indices Absolutos: Avaliam a qualidade do modelo
per se, sem comparagcao com outros modelos: RMR,
GFI

Indices Relativos: Avaliam a qualidade do modelo
sob teste relativamente ao modelo com pior
ajustamento (mod independéncia) ou melhor
possivel (mod saturado): NFI, CFI C

Indices de Parciménia: indices relativos que
incluem uma penalizacao devida a complexidade do
modelo: AGFI, PGFI, PCFI

Indices baseados na teoria da informac3o:
Apropriados para comparar varios modelos
alternativos que ajustem aos dados (AIC, BIC, ECVI)
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3. AVALIACAO DA
QUALIDADE (2)

(2) indices de qualidade de ajustamento

Avaliam a distancia relativa entre a matriz
dos dados e a matriz da populacao.

Indices recomendados de acordo com
Maroco, 2013

Wl ANALISE DE DADOS EM GRH

Estatistica Valores de Referéncia

(Macro do AMOS: \cmin; \p)

X2 e p-value (H,: O Ajustamento é perfeito)

Quanto menor melhor
p>0.05

X2{df (Macro do AMOS: \cmindf)

< § — ajustamento sofrivel
< 2 - ajustamento aceitavel
~ 1 — ajustamento bom

CFl  (Macro do AMOS: \cfi)
GFl (Macro do AMOS: \gfi)

<0.8 — ajustamento mau
[0.8;0.9[ - ajustamento sofrivel
= 0.9 — ajustamento muito bom

PGFl (Macro do AMOS: \pcfi)
PCFI  (Macro do AMOS: \gfi)

< 0.6 — Ajustamento mau
[06; 0.8[ - Ajustamento bom
>0.8 — Ajustamento muito bom

RMSEA (com 1.C. 90%)

e

p-value (H,: rmsea<0.05)

(Macro do AMOS: \rmsea; \pclose)

> 0.10 - Inaceitavel

10.05;0.10] - ajustamento sofrivel
=0.05 - ajustamento bom

p-value >0.05 (>0.5 segundo Jéreskog)

AIC (Macro do AMOS: \aic)
ECVI (Macro do AMOS: \ecvi)

S6 para comparar modelos
Quanto menor, melhor...

17
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3. AVALIACAO DA
QUALIDADE (3)

(2) ) Analise de residuos, estimativa de
parametros e fiabilidade individual de
indicadores

Ou seja: O modelo pode ter um bom
ajustamento global, mas ainda assim
apresentar um mau ajustamento local.
Para fazer o diagndstico de possiveis
problemas locais:

Wl ANALISE DE DADOS EM GRH

A. Avaliar os residuos estandardizados (problemas:

B.

residuos > 2, outliers)

Avaliar os erros-padrao assimptoticos dos
parametros do modelo e sua significancia
(problemas: erros-padrao superiores (2x) a
estimativa do parametro; parametros nao
significativos )

Fiabilidade individual dos indicadores/manifestas
(problemas: Valores de R? <,025)

18
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3. AVALIACAO DA
QUALIDADE (4) =

//*\\ Rejei¢ao do
Estimaggo do C k\\//) moaelo
. . Modelo\‘

(2) E se a qualidade nao for boa?? Avaliagao

Recolha de C) %%gicﬂj:nctjc)
-~ Dados Espegificagéo e
E pratica corrente, modificar o modelo O e ede
eliminando vias nao significativas, () Elaboragdo dp ﬁ‘
i A modelo Tedri
libertando parametros ooele Teenae
anteriormente fixos, fixando parametros e

anteriormente livres, correlacionar erros, TEORIA

* Marbco recomenda apenas alterar = *A atualizacdo do modelos deve

Os softwares também d3o outras pistas: o modelo se houver fundamentos ser feita sequencialmente,
indices de modificacdo! tedricos para + Ml > 11 comegando por libertar o

parametro com maior Ml
19
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3. AVALIACAO DA
QUALIDADE (4)

(2) E se a qualidade nao for boa??

E pratica corrente, modificar o modelo
eliminando vias nao significativas,
libertando parametros

anteriormente fixos, fixando parametros
anteriormente livres, correlacionar erros,

Os softwares também dao outras pistas:
Indices de modificagao!

Wl ANALISE DE DADOS EM GRH

Maroco recomenda apenas alterar o modelo se houver
fundamentos tedricos para o fazer e/ou de Ml > 11

A atualizacdao do modelos deve ser feita sequencialmente,
comecando por libertar o parametro com maior Ml até chegar
ao parametro de menor M.

20
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5. VALIDACAO

Pressupostos

1. Normalidade multivariada

2. Linearidade: aplicado a matriz de
correlacOes (entre manifestas)

3. Covariancias amostrais nao-nulas
4. Multiplos indicadores para cada latente
5. Auséncia de Multicolinearidade
6. Amostras de “grande” dimensao
7. Modelos sobre-identificados

8. Medida “forte”

9. Sem outliers

Wl ANALISE DE DADOS EM GRH

Pode ser avaliada com:

1. Assimetria (skewness - "sk") e Curtose (kurtosis -
"ku") | Kline (1998): Valores de |Sk| <3 |[Ku| <8

2. Graficos de dispersao

3. Matriz de correlagdes (p<0,05)

4. Multiplos indicadores | Modelo

5. Auséncia de Multicolinearidade | VIF

6. N>200 — 400 ; 15 sujeitos por variavel manifesta; 5
sujeitos por parametro a estimar

7. Medidas de ajustamento local

8. Escala (ordinal) deve ter pelo menos 5 pontos

9. AMOS testa a distancia de Mahnalobis *convém que p1

seja pequeno (0.05-0.10), e p2 seja grande (>0.05-0.10), caso contrario a observacdo

deve ser um outlier multivariad 21
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4. REPORTE

Recomendacoes:

* Reporte baseado nas estimativas
estandardizadas

* Incluiinformacao sobre a variancia
explicada pelo modelo de medida (em
geral e para cada item);

* Incluiinformacao sobre a variancia
explicada pelo modelo estrutural (em geral
e para cada VD);

* Inclui representacao visual do modelo

22
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Analise Estatistica

O modelo de moderagdo do Conhecimento prévio a matematica sobre a Motivacdo matematica e a influéncia
destas variaveis na performance a matematica foi avaliado por intermédio de um modelo de equagdes estruturais
com efeito de moderacdo. O factor latente de moderacdo foi definido pelo produto, em pares, dos itens reflexos
dos factores ‘Conhecimento Prévio’ e ‘Motivagcdo Matematica’. O ajustamento do modelo de moderacéo foi
efectuado em duas etapas: a primeira de validagdo do modelo de medida, e a 2* de ajustamento do modelo de
moderacdo. O ajustamento do modelo foi feito por recurso ao software AMOS (v. 17, SPSS Inc, Chicago, IL). Na
avaliacdo da qualidade do ajustamento utilizaram-se os indices CFI, GFI e PCFI, PGFI tendo-se considerado que
estes indicavam um bom ajustamento para valores superiores a (.9 e 0.6, respectivamente. Utilizou-se também o
RMSEA com 1.C. a 90% e a probabilidade do rmsea<0.05. Considerou-se que um I.C. para o RMSEA a 90% com
limite superior inferior a 0.10 ¢ indicador de um ajustamento razoavel, e que o ajustamento ¢ muito bom quando
o limite superior do I.C. ¢ inferior a 0.05 (Maroco, 2008). A significancia do efeito de moderacdo foi avaliada
com um teste a significancia do coeficiente de trajectoria associada ao efeito de moderagao.

Resultados

A figura 1 ilustra as estimativas dos parametros quer do modelo de medida (pesos factoriais) quer do modelo
estrutural de moderagdo. Observou-se um efeito de moderagao do Conhecimento prévio sobre a Motivagdo
matematica na performance a matematica (3py; cppan=0-220; p<0.001). Sendo o efeito de moderagdo positivo
podemos afirmar que quanto maior for o conhecimento prévio maior sera o efeito da motivagdo matematica sobre
a performance a matematica. Observaram-se ainda efeitos directos do Conhecimento (Bpy -\=0.429; p<0.001) ¢
Motivacao (Bpy y=0-409; p<0.001) estatisticamente significativos.

©Maroco
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Figura 1. Modelo de moderacgido do conhecimento prévio sobre a motivagdo Matematica na performance a Matematica
(X?%/df=1.8;CFI = 0.991;GFI =0.973 ; PCFI =0.721 ;PGFI =0.599 ¢ RMSEA=0.04; p=0.891; I.C. 90% ]0.026; 0.053[ )

24
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Modelos de equacoes
estruturais

Objetivo: Gerar um modelo com variaveis
manifestas e latentes com o programa AMOS
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©Maroco

Segundo Warren, White & Fuller, (1974) a performance de um conjunto de administradores
de uma cooperativa agricola é fungao de um conjunto de variaveis latentes que incluem o
Conhecimento técnico, o Valor e a Satisfacao dos gestores. Cada uma destas variaveis foi
avaliada com um teste constituido por duas metades equivalentes. O modelo GEE
proposto € ilustrado na figura seguinte:

Cl

62 Gz

Conhecimento

Ajuste o sub-modelo de medida, e o modelo geral. Avalie a qualidade do ajustamento em
cada uma das etapas.

26



1. Desenhar o modelo

Organizacgao:

Menu de Comandos [

Botdes de Desenho e

Especificagdo de
Comandos

Area de
Mensagens de
Analise

¢t Unnamed project : Group number 1 : Input

=1l

Eile

Edit Yiew [Diagram Analyze Tools Plugins Help

- 2 aill] it

= = [T

||||| i) Default model

F Unstandardized estmates
L
b7

3

[ Modelo modificado nas 2 ame

e Modelo modificado nas 2 ame
.. |Modelo ongnal nas 2 amosir:

o i

4 4

©Maroco

Botao

Funcéo

Fungéo

Desenhar variavel manifesta

Desenhar variavel latente

Visualizar variaveis na base de dados

Visualizar variaveis no modelo

Desenhar modelo de medida

Desenhar trajectéria causal (Causa para efeito)

Selecgéo do ficheiro de dados e grupos para
analise multi-grupos

Desenhar relagdo correlacional

Especificacao das propriedades da analise
(método de estimacao; outputs, ...)

Adicionar ‘erros’ as variaveis

Seleccionar um objecto

Seleccionar todos os objectos

De-seleccionar todos os objectos

Ex10cEER: TE0n

Copiar objecto

Mover objecto

Apagar objecto

Calcular estimativas dos pardmetros e medidas
de ajustamento do modelo

Visualizar o Output com resultados da analise

Modo de ‘Desenho’ do modelo

Modo de ‘Visualizagio’ das estimativas dos
Parametros e estatisticas de ajustamento

Estimagao Bayesiana

Especificar propriedades dos objectos

Anélise Multi-grupos

Estimar o
modelo

Pesquisa de Especificaco (Specification search)
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1. Desenhar o modelo

©Maroco
O e~
e
» Seleccione a ferramenta de desenho do modelo de medida O-*D - W Te
' » Proceda de forma semelhante OO~ O
(O cursor, na area de desenho, passara de N para ¥ ) para os restantes factores: ,)__D,k/' N0
» Clique, com o botdo esquerdo na area de desenho, pia ' O )
e arraste o cursor para desenhar um circulo com as | o
dimensdes apropriadas; =
. prop ’ - » Desenhe as trajectorias causais entre os
» Clique duas vezes com o botdo esquerdo para O
s . . factores usando a ferramenta OB
adicionar 2 itens e respectivos erros o
Nota: A ferramenta do modelo de medida, identifica por . . OTD:""“;— X,
. o o | » Desenhe as Correlagdes entre os factores usando O — -0
defeito uma trajectoria da v. latente para o 1° item e as OLh
. . a ferramenta «» i %
trajectdrias dos erros para os itens, com o valor 1. Estes O
valores podem ser alterados posteriormente
» Rode os itens para o lado esquerdo usando o botao O~ —~ Nota: No AMOS texF, as correlagr.:es entre factores O
) latentes sdo assumidas por defeito, mas no AMOS . J N\ TN e
. . O "D\' g " EI‘ C
O__D/ graphics, WYSIWG e portanto estas tém de ser ] (_Q—'— i"\t}@
desenhadas!... 5t _ Jjé
l,1 D‘.— _—



2. ldentificar variaveis

> Abrir o ficheiro de

2. Lap Zndt % L iR 5 Can ondt
g’g& mod1 : Group number 1: Input

dados

/2.5 File Edit View Diagram Analyze Tools Plugins Help
TE @ i
‘_
‘Group mumber 1
[Titie
|

O NEE: I
# X (3 0o

Iot X0 Default model
Lo L h

s l Data Files
il
- Group Name | File | Wariable I Value | N
Group number 1 BDAMOS_waren .cav 58/98

File Name I ‘working File

[ Allow non-numeric data

[ Assign cases to groups

| Help |
p View Data | Grouping Variable | Group Value |
g oK | Cancel

r—

» Cliqgue com o bot&o direito do rato em cada um dos
circulos (v. latentes) e seleccione a opgédo ‘Object Properties’

1
m : ¢%: Object Properties

L5 ]
: @,@“‘W-,,kﬁ‘k"? ILO Tet | Perameters | Colors | Fomat | Visbity |
S%C 5 O Esth £ Font size Font style
++ Draw Covariance e O @ = | (oo 3]
\ K Erase DELETE Variable name
w M Move CTRL+M Conhecmento -
% Duplicate %
i35 Move Parameter Yimaiatel Set Detfault
Mt Shape of Opject l :
Y%, Touch Up CTRLeH
= Toggle Observed/Unobserved
{} Rotate
3% Reflegt

» Digite “Conhecimento” na caixa ‘Variable name’:

e cligue no botdo & para fechar o menu.
» Proceda de igual modo para as restantes
v. latentes

» Clique no botdo & para listar as variaveis presentes na base de dados

©Maroc

» Clique em cada variavel e, sem largar o botdo esquerdo do rato, arraste-as até ao item

correspondente:

» Adicione o erro (Disturbance) da v.lantente ‘Performance’ (d1). Clique na ferramenta

e clique em cima do ‘circulo’ da ‘Performance”:




3. Identificar variaveis
©Maroco

» Adicione os erros manualmente, ou recorra ao menu ‘Plugins » Name unobserved variables': » Finalmente, recorra as ferramentas de retoque para melhorar o aspecto grafico do modelo.

, s — Devera obter algo do tipo:
5254' Eﬂ‘ Riagram  Analyze Tools | Blugins | Help V
LR e Boelie ?
i o W Draw Covanances
+— & Growth Curve Model
— % Name Parameters
Name Unobserved Vaniables
Resize Observed Variables

8o 0

;%?é@o ic=m

‘1-.
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4. Estimar o modelo

» Clique no botao e especifique o método de analise e as opgdes de output, clicando nas
patilhas ‘Estimation’ e ‘Output’ (as outras sdo irrelevantes na maioria das aplicacdes de AMEE)

#f} Analysis Properties

|7 [ ¢y Analysis Properties

[ [

Discrepancy
% Maximum likelihood
" Generslized least squares
" Unweighted least squares

" Scale-free least squares

For the purpose of

" Asympictically distribution-free

Estimabon, | Numedcal | Biss | Output | Bootstrap | Pemutations | Random # | Tee |

 Estimate means and
intercepts
™ Emuisrels

,_ Chicoract

ing fit with i data:

" Fit the saturated model

1 " Fit neither model

{5 Fit the saturated and independence models

only

Estimation | Mumerical | Bias

[¥ Minimization histony

¥ Standardized estimates

¥ Squared multiple corelations
™ Sample moments

[ Implied moments

[ & implied moments

I™ Residual moments

¥ Modification indi

Output | Boctsrap | Pemutations | Random #| Te |

¥ Indirect. direct & total effects
¥ Factor score weights

™ Covariances of sstimates

¥ Correlations of estimates

W Critical ratios for differences
W Tests for normality and cutliers

I™ Obsenved information matrix

1 Threshold for modification
indices

» Clique, finalmente, no botéo para ajustar o modelo

©Maroco

Nesta fase, e se ainda n&o o fez anteriormente, o AMOS pedir-lhe-a para gravar o seu modelo

grafico, dando um nome ao ficheiro do tipo *.amw:

[ save ns

File name:

GO-TI" « Anest » AMOS b examos

~ |49 |{ search

Name Date modif.. Type Sae
A ESWheatonamw

A identamw

& PathMecsaticntuthan,amw

& PathModerstion_cEuthnarmw

* A PathModerstionEuthan.emw

A Reg Linesr Multpls Multivariads.smw

" & Reg Linesr Multipls Univariads.smw

@ Regreszio Linear Multipla.amw
8 Regressio Linear Multipla Multivariads ..

Save 25 type: [Input file (amm)

* Hide Folders

[Come ) [Ccomcel

] Digite aqui o nome do ficheiro
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5. Analisar o output

Para visualizar o ficheiro de output completo (Wheaton.AmosOutput)

» Clique no botdo E& ou no menu ‘View » Text Qutput’' (F10), para abrir o visualizador de

outputs (AMOS output)

N° de casas decimais dos
valores no output

Arvore de Navegagao
do Output

Clicar no sinal [+] para
expandir a arvore de
navegacdo e visualizar
o output na janela de
output

colunas

Espacamento entre

£8t Ames Output

v

b &W e

mE |z -7 -0

(FEORmE : @

Whesion_final amw
& Anaiysis Summary
Hotes for Group
B Viadable Summany

Analysis Summary
Date and Time

Date: donngo, 12 de Crutubeo de 2008
Time: 11:05:02

Title

Wheaton_finak domingo, 12 de Oumbro de 2008 1105

-

Aread
Outpu

e.g. Coeficientes de trajectdria e pesos factoriais (Regression weights):

Estimativas do coeficiente

©Maroco

FI Estimativas dos SE da estimativas

Trajectérias )—\

[

12 Amos Output I M
R&ME = -7\-0 [FOEE @] |
Wheaton_final.amw - N
& Analysis Summary | | Regression Weights: (Group number 1 - Default m¢del)
Notes for Group J
R Estmate SE CR P Label
'arameter summary
& Notes for Modal 2 Performance <--- Valor 231 100 2300 .021 par 5
& Estmates Performance <--- Conhecimento 494 177 2786 .005 par 6
& Scalars . =
Performance <--- Satisfagdo 077 061 1259 208 par9
Standardized Regressi. Cc2 <--- Conhecimento 1.000
Covanances Cl1 <--- Conhecimento 1463 344 4252 *** parl
Crasistions: V2 <--- Valor 1.000
Vanances:
Squared Mutiple Correl Vi <--- Valor 1311 318 4128 *** par 2
& Matnces | S2 <--- Satisfagdo 1.000
1\ o ! L S1 <--- Satisfagdo 1263 699 1806 071 par 3
Pl <--- Performance 1.000
P2 <--- Performance 867 116 7450 *** par 4

C.R. Critical Ratios
Z=Est/SE ~N(0,1)

P-value associado a
Z=Est/SE ~N(0.1)
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5. Analisar os outputs

Os resultados da analise podem visualizar-se rapidamente na area de desenho, ou
extensivamente no ficheiro de output.

Standardized estimates

Correlagéo entre factores
Conhecimento e Satisfacdo
(R{‘rllllll_‘:llf:(}'[}ﬁ)

Estatistica do \? e respectivo p-value

Coeficiente de trajectoria do

factor Conhecimento para factor
Performance (3p-=0.52)

eqplo de Performance(Warren et al. 1974)
X2(14)=10.335, p=737

Proporgéo da varidncia do
item P1 explicada pelo factor
Performance (R?p, p,,~=0.73)

Peso factorial do factor
Performance no item P2
(“J;*z;’r-;f:U-BQ)

©Maroco

Para visualizar o ficheiro de output completo (Wheaton.AmosQOutput)

» Cligue no botdo &= ou no menu ‘View » Text Output’ (F10), para abrir o visualizador de
outputs (AMOS output)

Ne de casas decimais dosh /ﬁ{ Espacamento entre

valores no output colunas

£%¢ Ames Output v L] b
REME oe -7 -0 FOEE: R
Wihaaton_final amw

Arvore de Navegacao i R
o Vindable Summeny Date and Time

do Output * | - Pt sy

* :::u’:"‘“d‘* Date: dosingo, 12 de Outubro de 2008 .
& Mod - Time: 11:05:02 - Area de

Clicar no sinal [+] para |k S| R Output

nzggggg : :'f *_’;szfz ¥ e e Wheaton_isat doningo, 12 de Ovtubro de 2008 1105

visualzar
o output na janela de . .
output
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5. Analisar os outputs
©Maroco

e.g. Coeficientes de trajectéria e pesos factoriais (Regression weights): e.g. Indices da qualidade do ajustamento (Model Fit):

Trajectérias Estimativas do coeficiente 181 Amos Ovtput B
l"l Estimativas dos SE da estimativas RO@UE T -7 -0 -FIDWME 0
= Model Ft - -
[ Model Fit Summary e
) Arves Ot \ [ ] SIS - cifica, o
AT Baseine Compansone o
ReWs o ma -7\ -0 -[FOJE M 2@ | I Z=Fst/SE . et
Wheston_fina amw 7 et J Model NPAR CMIN DF P CMINDF ol
& Analysis Summary Regression (Group number 1 - Default m RMSEA i Defauk model 22 103385 14 %7 738 Refererce G r
Notes for Group e }H 1 j / P-value as A . Sawated model % 000 0 @5' T
@.Vmw Estmate SE CR P Labdl Z=E8t/SE Independ: model 8 243768 28 000 £.706 [ ’ Pt Qstore
Parameter summary St = % N
& Notes for Model Performance <--- Valor 231 .100 2300 .021 par_5 RR G ‘%‘{fi::' -]
& Estmates Perf e <--- Conheci 494 177 2786 005 par 6 o rombor 1 4 @ M Amen 70 o
P a0 Model RMR  GFI AGFl PGFI 1 @ Mew i Joce 6.0 The O (gueines o ¢ ) s dvns for
Regression Weights Performance <--- Satisfagdo 077 061 1259 208 par 9 Defackt model 003 935 379 5 Jorern b v T e g = 7o
egression Weig 2 2o Conhioik 1.000 Detn A model Saturated model 000 ~ Gl vake "‘:‘v—-v"""' m.“s’_"
: cl <--- Comhecimento 1463 344 4252 *** par | fndependencemodl 0257 i1 075 for the Dubet o ol || 3 o e Gn=|—-£—
- Comelations: V2 <--- Valor 1.000 Baseline Comparisons - % (Q dspmnax C Mesases ’ ” N
i : . ———— L : il Mmo’_‘-nmm‘- the discrepancy in Appanda
Sgua!dWeCuld Vi < VaI.or . 1311 318 4128 par_2 P NFI  RFl [ TR pe :...n-m- $and £, 1 obtaned by evakatng F wth 5{s) _ g+ 9= L 2 AR
e - 52 Sl ¢ 1.000 Deltal thol [Delta  tho2 -4 Comparecrna 12 a1 exception hes 1o be made for maxmum ieitsod estimation, snce (02) in
R — S1 <--- Satisfagdo 1263 699 1806 071 par3 Defauk model 958 915 [1016 1034 1000 S8t ] dopaiick s dinine plat g SO pitpion & gty e
P1 <-—- Performance 1.000 Sanxrated model 1,000 1.000 1.000 -] Secked et v Jl‘:,u; s‘l')nmm ™
P2 <--- Performance 867 116 7450 *** par 4 Kacpodeatemodel ) 000004000 M00; 0% .éﬁ AR
= o ’ (£9; 8'%)= 4 ol (s - 52|’
E possivel clicar Faomein iy L Ol )
em todos 0s ‘«‘ Aoosntn G Rascairg with gg! =\"“ﬁm).wﬂmim 15 the maomum Ikeshood estimate
elemento do output h A
“ P O is less than or equal to 1. A value of 1 indicates a perfect fit.
e chamar o “help - o ||| use the gttt macra to seploy 6 o0 path dram.
do AMOS

34




	Slide 1:  ‘Como testar um modelo?’  Modelo Geral de Equações Estruturais (MARÔCO, 2013)     
	Slide 2
	Slide 3
	Slide 4
	Slide 5
	Slide 6
	Slide 7
	Slide 8
	Slide 9
	Slide 10
	Slide 11
	Slide 12
	Slide 13
	Slide 14
	Slide 15
	Slide 16
	Slide 17
	Slide 18
	Slide 19
	Slide 20
	Slide 21
	Slide 22
	Slide 23
	Slide 24
	Slide 25: Modelos de equações estruturais  Objetivo: Gerar um modelo com variáveis manifestas e latentes com o programa AMOS               
	Slide 26
	Slide 27
	Slide 28: 1. Desenhar o modelo
	Slide 29: 2. Identificar variáveis
	Slide 30: 3. Identificar variáveis
	Slide 31: 4. Estimar o modelo
	Slide 32: 5. Analisar o output
	Slide 33: 5. Analisar os outputs
	Slide 34: 5. Analisar os outputs

